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About the User's guide

This User's guide explains how to install and use the miroVIDEO Pinnacle
Systems hardware and software.

In the margins are subheadings to help you quickly find your way through
this manual.

Important text passages are marked with the “notepad” and this format.

Numbers mark step by step instructions:

1. Start Windows.

Bullets mark instructions for optional steps the order of which is not
important.

• Connect the miro board to the microphone.

All keyboard commands appear in this font:

install <↵↵>

<↵↵> represents the enter key.

Menus, commands, options or buttons which the user can select are written
in italics.

For your own safety

In the interest of your own safety and the flawless functioning of your new
product and computer system please note the following:

s Computer components are sensitive to static charge. Divert any
electrostatic charge from your person before touching the components
with your hands or any tools.

s Before opening the computer make sure that the power plug is
disconnected from the main socket.

For changes that have occurred after the manual has been printed, refer to
the README file/s on the CD-ROM supplied with your system!

Subheadings
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Overview

GENERAL

What is miroVIDEO PCTV?
miroVIDEO PCTV is a TV tuner/capture board which can be used with any
PCI computer (PCI bus as of revision 2.1)*. miroVIDEO PCTV brings all
functions which are usually provided by your television set to your PC. In
addition, you can digitize (record), edit, and play back single frames or video
clips.

What is miroVIDEO PCTV pro
miroVIDEO PCTV pro consists of a miroVIDEO PCTV base board and an
add-on board which offers further functions, such as stereo TV, MTS
(Multichannel Television Sound), and an FM stereo radio.

If you already own a miroVIDEO PCTV board, you can upgrade this board
with the miroVIDEO PCTV pro.

The miroVIDEO PCTV pro upgrade is not available in all countries. Please
ask your retailer!

FEATURES

The PCI busmastering** technology and a suitable graphics board enable a
digital TV overlay. That means that the TV image is transferred via the PCI
bus, superimposed onto the image generated by the graphics board, and
displayed in a scaleable window.

The miroVIDEO PCTV base board is equipped with Composite and S-
Video inputs to which connect a VCR, a camcorder, a video camera, or a
satellite receiver.

miroVIDEO PCTV is also equipped with a TV tuner which is compatible
with cable TV and allows you to receive any TV channel using a common
TV antenna or cable TV.

The miroVIDEO PCTV package contents include the following software:

s miroTELEVISION is an application you can use to select the channels
and the inputs.

                                                       
*   If you are in doubt, please refer to the documentation of your motherboard.
** For a TV overlay, the PC and the graphics board have to meet certain requirements (see the “System

requirements” section). You will find a list of successfully tested graphics boards in the Appendix.

miroVIDEO
PCTV pro

upgrade

miroVIDEO 
PCTV
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s With the miroTELETEXT application (only available in Europe) you can
make use of the teletext function offered by many TV stations and save
and print teletext pages.

s VidCon32 lets you record single-frames or video clips directly to hard
disk (uncompressed and compressed, in the AVI format and with a size of
768 x 576 pixels).

s Kai´s Power Goo, image editing application.
s Intercast Viewer, an application you can use to view HTML teletext

pages (modern type of teletext). The Intercast Technology allows the
broadcasting of text and images in HTML format along with a
conventional TV broadcast signal. HTML is the page layout (Hypertext
Markup Language) which is commonly used in the Internet. At the time,
only a few channels broadcast intercast pages.

s Windows 95 and Windows NT drivers.

miroVIDEO PCTV pro also offers:

s a stereo and MTS audio decoder,
s miroRADIO, the tuner application for the FM radio module,
s a video editing application on a separate CD.

Windows NT:
Under Windows 95, miroVIDEO PCTV pro offers the full functionality. At
the date of release, only the miroVIDEO PCTV functions are supported
under Windows NT, (only TV without stereo, only single-frame capturing).
Under Windows NT miroVIDEO PCTV (pro) does not support
miroTELETEXT, Intercast Viewer, Kais Power Goo, VidCon32.

miroVIDEO
PCTV pro
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Before you begin

SYSTEM REQUIREMENTS

To install miroVIDEO PCTV (pro), your computer system has to meet the
following requirements:

Hardware
s Computer:

Pentium computer (recommended: Pentium 90 MHz) with an empty
master PCI slot (PCI-system 2.1 or higher) and CD-ROM drive.

s Memory:
At least 8 Mbytes memory (recommended: 16 Mbytes)* .

s Graphics board:
A graphics board with at least 8 bits color depth (256 colors).

DirectDraw support:
Before you begin to work with the miro applications, a graphics board with a
complete DirectDraw must be installed.**

The miro installation program checks to see if DirectDraw has been installed.
If this is not the case, it will install DirectDraw automatically.

s Sound board:
If you want to record sound, modify audio clips, or control the volume
using the miro software, your computer has to be equipped with a
Windows-compatible sound board (standard or miro sound board) having
a free audio input.

s Monitor:
Standard VGA monitor. To receive all the benefits from the graphics
board, you need a monitor which is especially suited for your graphics
board.

Software
s Windows 95 or Windows NT 4.0.
s If you want to use the Intercast Viewer, the Internet Explorer has to be

installed on your computer. The Internet Explorer is contained on the
supplied CD-ROM and can be installed using the install program.

                                                       
*  If you want to use the miroMEDIA PCTV board primarily for capturing or for video conferencing, your

computer should be equipped with at least 16 Mbytes of memory.
** The following graphics boards support DirectDraw:

 miroCRYSTAL VRX, miroMEDIA View, miroMEDIA 3D, miroVIDEO 22SD, graphics boards with a
 TrioV64+ or S3 ViRGE/ViRGE VX chip.
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Video devices
s S-Video input and composite video input:

The miroVIDEO PCTV connects to any video source (VCR, video
camera, laserdisk) generating a composite video or S-Video signal in
PAL, NTSC, or SECAM quality, e.g. VCR, camcorder, video camera or
satellite receiver, independently of the video system you use (e. g. VHS,
S-VHS, Hi8, Video 8).

Audio devices
s Internal/external audio output:

The internal audio output (see board layout below, ST 7) connects to the
internal audio input of a sound board. The external audio output connects
to the Line In input of the sound board or to powered speakers.

s Internal audio input:
You can connect the internal audio input to the audio output of a CD
player. The software allows you to loop the internal audio output through
to the external audio output (see also the “miroTELEVISION” chapter in
the online manual).

ST1

ST7

1

26

TV tuner

Booktree
video

decoder

Connector and
3 holes for 
attaching the 
upgrade

TV antenna input

Internal
audio output

Internal
audio input

External 
audio input

Composite 
video input

S-Video
input

ST7

ST1

ST6

miroVIDEO PCTV board layout

ST1

ST7

1

26

Booktree
video

decoder

Small slot shield

Upgrade

Radio tuner

Antenna cable

Base board

ST7

ST6

TV tuner
TV antenna input

Internal
audio output

Internal
audio input

External 
audio input
Composite 
video input

S-Video
input

Antenna 
input

(radio)

miroVIDEO PCTV pro board layout
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Antenna/cable
s Connect the TV antenna input of the base board to a video antenna

(coaxial connector) or a cable connector.
s If you installed the miroVIDEO PCTV pro:

connect the radio antenna input of the upgrade to the radio antenna
(coaxial connector) or a cable connector.

s To connect video devices to the miroVIDEO PCTV base board, you need
suitable cables (RCA or S-Video cables).

PACKAGE CONTENTS

Before beginning the installation of your multimedia board, please check to
make sure your package is complete*:

miroVIDEO PCTV** Internal audio cable (a) or
external audio cable (b)***

Adapter for the TV antenna
connector (may be plugged
in already)

CD-ROM containing
drivers, applications, online
documentation

CD-ROM with additional
applications****

This Quick Installation
Guide

                                                       
* Depending on the delivery scope, the actual package contents may be different from the package contents

listed in the manual.
**    For model and serial number of your miro board, refer to the label on the board.
***     Depending on the delivery scope, an internal or external audio cable is included in the package contents.
****    Depending on the delivery scope, either one or two CDs will be supplied.
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The miroVIDEO PCTV pro package contents contain the following
components in addition to the ones mentioned above* :

ST1
1

26

miroVIDEO PCTV-Ugrade-
Modul

large slot shield for an
expansion slot, small slot
shield for a serial interface

adapter screw

washer and nut coaxial adapter for the radio
antenna connector

video application on CD-
ROM

If any parts are missing, please contact your dealer or retailer. You will find
the complete software and documentation on CD-ROM. Diskettes are not
included in the package contents.

Multimedia boards are sensitive to static charge. To avoid damage that may
occur by static charge, leave the board in its antistatic packaging until
installation. Keep the packaging for possible future transportation.

                                                       
* Depending on the delivery scope, the actual package contents may be different from the package contents listed in

the manual.

miroVIDEO 
PCTV pro
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Hardware installation

PREPARING THE INSTALLATION

The only tool you need for the installation is a screwdriver. Proceed as
follows:

1. Discharge yourself of static charge by touching the power unit casing.

2. Turn off your computer and all peripheral devices. Disconnect the
computer from the power supply and all necessary components.

3. Loosen the computer's cover screws and remove the cover.
4. Select a free PCI (busmaster*) slot. Remove the slot's cover at the back

of the computer and keep the screw .

Slots

Slot shields

Power
supply
unit

PCI slots

CONNECTING miroVIDEO PCTV PRO

Only for PCTV pro:

Use one of the plates included in the package contents which provide a hole
for the antenna cable. Depending on whether an opening of a free expansion
slot or of a serial interface is available at the back of your computer, use the
large or the small metal plate through which you can lead the antenna cable.

1. Remove a slot shield or the shield of a serial interface from the back of
your computer.

2. Connect the coaxial adapter to one of the supplied metal brackets using
the nut and washer provided.

                                                       
* If you are in doubt, refer to the manual of your motherboard.
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Nut

Nut

Washer

Washer

Screw

Screw

Coaxial adapter

Coaxial adapter

Small metal plate

Large metal plate

Connecting the radio antenna cable

3. Fit the large or the small metal plate with the appropriate screws to a free
slot at the back of your computer.

4. Attach the antenna cable from the upgrade module to the adapter screw.

5. Carefully attach the supplied coaxial adapter to the adapter screw.

ST1

ST7

1

26

Booktree
video

decoder

Small slot shield

Upgrade

Radio tuner

Antenna cable

Base board

ST7

ST6

TV tuner
TV antenna input

Internal
audio output

Internal
audio input

External 
audio input
Composite 
video input

S-Video
input

Antenna 
input

(radio)

Connecting the adapter screw to the slot shield

INSERTING miroVIDEO PCTV (PRO)

1. If necessary, connect the internal connectors of miroVIDEO PCTV to the
corresponding devices.

2. Carefully insert the board into the PCI slot by holding the board at the top
and gently pushing both ends into the slot at the same time. Press onto the
upper edge of the board to make sure it is firmly seated in the slot.

Connecting the
sound board

(internally)
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2. Don't force the board into the slot! You run the risk of bending the
contacts. If the board does not fit easily, pull it back out, and try again.

AFTER THE INSTALLATION

3. Fasten the board's bracket at the back of the computer using the screws
you saved from the shield.

4. Put the cover back on the computer and reconnect the peripheral devices.

For more information on how to connect the external devices, please refer to
the “Connecting external devices” chapter.
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Software installation

This section explains you how to install the miroVIDEO PCTV (pro)
software. During the installation, the miroVIDEO PCTV program group will
be created and the Windows 95 or Windows NT drivers and the tools will be
copied into this group.

WINDOWS 95
The course of the installation depends on whether you just installed the
board or if you want to update an already existing driver.

If you only wish to update your current driver or just install the radio
module, please read the “Updating the driver” section on page 13.

We recommend you to determine the Windows 95* version you use before
installing the software. For further information on identifying the Windows
version, please refer to the Appendix on page I.

miroVIDEO PCTV (pro) has just been installed...
Once you have installed the miroVIDEO PCTV (pro) board in your
computer, the board will be detected as a new hardware component.

After Windows 95 has started, the New hardware found dialog box will
appear.

1. Click on the Driver from disk provided by hardware manufacturer
option.

2. Insert the CD-ROM from the miroVIDEO PCTV (pro) package contents.

3. Click Browse... .

4. Switch to your CD-ROM drive to the \DRIVERS directory. When the
MIROPCTV.INF file appears, click OK.

The Assistant for Device Driver Updates appears:

1. Click on Next.

2. Insert the CD-ROM from the miroVIDEO PCTV package contents.

3. Click on Other Locations... . Click on Browse.

4. Switch to your CD-ROM drive to the \DRIVERS directory. Click OK.

In the Select device window or Assistant for Device Driver Updates window
(OSR 2) the miroVIDEO PCTV (pro) board has already been selected.

                                                       
* You can check which Windows 95 version you use by entering the DOS command ver. The OSR 2 (OEM-
Service-Release 2) version the version number Windows 95. [Version 4.00.1111]; the August Windows 95 Release
has the version number Windows 95. [Version 4.00.950].

Software update/
radio module

Windows 95
(Release August

95)

OEM Service
Release 2

Both versions
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Windows 95 (Release August 95)

OEM Service Release 2

5. Click OK or Finish.

The drivers are now being installed.

When you are being requested to insert a new data carrier, click on Browse
to select the path \DRIVERS.

• Click OK again.

The remaining files are now being copied.

6. When being requested to restart Windows 95, answer Yes.

7. After starting the computer select the Start menu in the Taskbar and the
Run... command. Depending on your CD-ROM drive enter:
d:\miro_win<↵> where d:\ is the drive of your CD-ROM drive.
Click OK.

The miroSETUP-Manager starts up.

8. Select the language you want to use for the installation. Click OK.

9. In the miroSETUP-Manager Module Selection, select the diskette icon
(Drivers and Programs).

OEM Service
Release 2

Both versions
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10.Enable the Programs for miroVIDEO PCTV (pro) for Windows 95 and
click Install....

The installation program is launched automatically.

11.Select the language you want to use for the installation. Proceed by
clicking Next.

12.In the Select components window the tools have been selected. Click on
Next to copy the tools.

In the Select components dialog box, please leave DirectX 5.0 selected.
Operating the PCTV board requires this DirectX version.
It is also vital that you install the online documentation because it contains
important information on connecting and operating the miroVIDEO PCTV
(pro) board.

If you have two video capture boards installed in your computer, you can
select the standard video capture board (the one you want to use for
capturing). This board is then the standard board used by your video capture
applications.

13.If two video capture boards are installed in your computer:
select your standard video capture board.

Now the Select TV Country dialog box appears.

14. Select the country where you are staying and click OK.

15.Read the information which now appears and click on Next.

16.If you selected Intel Indeo video interactive under item 12, the Intel
installation program will now be launched which will install the software
compressor. Please follow the instructions of the program.

17.When the DirectX 5.0 installation will be started, please follow the
instructions of the program.

After the DirectX installation has been completed, you can install the Internet
Explorer and the Intercast Viewer.

To use the Intercast Viewer, the Internet Explorer 3.x or higher has to be
installed. Please note that the Internet Explorer can alter the looks of your
Windows user interface.

The Explorer (approx. 55 MBytes) and the Intercast Viewer (approx. 16
Mbytes) occupy more than 70 Mbytes on your hard disk. The installation
takes some time.

18.Maximize the miroSETUP-Manager which has been iconized in the task
bar.

19.Please select the Internet Explorer 4.0 and click OK. Follow the
instructions of the installation program. Restart your computer when you
are requested to do so.

20.After having restarted the computer, start the miroSETUP-Manager again
as described under item 7. Follow instructions 8 and 10.

21.Select the Intercast Viewer. Click OK and follow the instructions of the
installation program. Restart your computer when you are requested to do
so.
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Now the installation is complete. The tools are dropped in the
miroVIDEO PCTV program group. Here you will find an option for
deinstalling the tools.

Updating the driver...
If you want to update the miroVIDEO PCTV (pro) driver, you must first
remove old drivers and entries from the Registry file. Please proceed as
follows:

1. If you have not done so already, start Windows 95.

2. From the miroVIDEO PCTV/miroMEDIA PCTV program group, select
the deinstallation program for the tools. Deinstall the tools.

3. From the Start menu, select Settings and the Control Panel.

4. Select Add/Remove software.

5. In the Install/Deinstall tab select the miroMEDIA
PCTV/miroVIDEO PCTV and click  Add/Remove.

If the miroVIDEO PCTV entry does not exist, please start the deinstall
program from the supplied miro CD-ROM (Version 2.00):
Select the Start menu in the Taskbar and the Run... command. Depending on
your CD-ROM drive, enter:
d:\drivers\uninpctv.exe where d:\ is the drive of your CD-ROM
drive. Click OK.

5. Restart your computer.

6. Install the drivers and the remaining software for your Windows 95
version described of page 12 item 11.

WINDOWS NT

If you want to use the miroVIDEO PCTV (pro) under Windows NT, you
need a graphics board which supports DirectDraw*.
To be able to install the software, you must have the administrator´s rights
under Windows NT.

miroVIDEO PCTV (pro) has just been installed...
To install the miro drivers for Windows NT, proceed as follows:

1. Start Windows NT.

2. Insert the CD-ROM from the miroVIDEO PCTV (pro) package contents.

The miroSETUP-Manager will start automatically.

                                                       
* DirectDraw is only supported as of Windows NT version 4.0.



14  miroVIDEO PCTV (pro)

If the miroSETUP-Manager does not start automatically or if you want to
start it at a later date, select the Start menu and the Run... command. Enter
d:\miro_win exe where d:\ is the drive of your CD-ROM drive. Click
OK to start the miroSETUP-Manager.

3. Select the language you want to use for the installation, confirm by
clicking OK. You are then in the miroSETUP-Manager Module Selection.

4. Select Drivers and Programs.

You are then in the miroSETUP-Manager Drivers and Programs window.

5. Enable the menu item Drivers for miroVIDEO PCTV (Windows NT) and
click Install... .

The miro installation program is started automatically.

6. Install the drivers and the remaining software for your Windows 95
version following the instructions described of page 12 item 11.

Updating the Driver...
If you want to update the miroVIDEO PCTV (pro) driver, you must first
remove old drivers and entries from the Registry file. Please proceed as
follows:

1. If you have not done so already, start Windows NT.

2. From the miroVIDEO PCTV program group select the deinstall program
(miroTELEVISION & Driver). Deinstall tools and drivers.

3. Install the new software as described under “miroVIDEO PCTV (pro) has
just been installed...” on page 13.
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Connecting devices

This illustrations show you the PCTV (pro) connectors:

       

VCR

VCR

The icons stand for:

VCR

TV antenna input

Audio ouput of the tuner/ audio output of the audio sources
attached to the internal connector, FM radio

Video inputs for camcorder, VCR,
TV tuner, satellite receiver

Composite/
Cinch

S-Video

  

       

Radio antenna input

miroVIDEO PCTV: Connectors miroVIDEO PCTV pro: Connector

CONNECTING THE VIDEO/AUDIO DEVICES

Most video cameras and VCRs are equipped with RCA outputs. More
advanced video cameras and VCRs also have S-Video inputs. To connect the
video inputs to the corresponding miroMEDIA PCTV (pro) inputs, you need
a suitable shielded cable (RCA or S-Video cable).

If your video source has an S-Video output, use this instead of the composite
video output because it provides a better video quality.

• Connect the video output of a  video camera or a  VCR to the composite
input of the miroMEDIA PCTV (pro).

CONNECTING THE ANTENNA CABLE

• If the adapter for the antenna connector (video) has not been attached
already, plug it onto the miniature RCA jack on the bracket.

• Connect the antenna cable to the now fitted adapter or connect the
antenna cable to the antenna input of the PCTV board.

Connecting
video camera/

VCR

TV
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Important:
The quality of your antenna cable influences the reception considerably

• miroMEDIA PCTV pro only:
Connect the radio antenna to the coaxial adapter or interconnect you
cable radio jack to the radio antenna input on your PCTV base board.

CONNECTING THE SOUND BOARD/POWERED SPEAKERS

• If you want to use the external audio output, connect it to the Line-In
input of your sound board using the external audio cable or to the
powered speakers.

Radio

Connecting the
sound board
(externally)
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PCTV applications

miroTELEVISION

Please note:
Under Windows NT not all functions of the miroTELEVISION application
are supported. These are among others the automatical detection of mono,
stereo and MTS reception, the detection of the channel name and the audio
options from the Settings dialog (see below).
Options which cannot be selected are grey.

To be able to use the miroVIDEO PCTV (pro) board for watching television
and videos, the following requirements have to be met:

s Installation:
To use miroTELEVISION, you have to have installed this application
from the CD-ROM included the miroVIDEO PCTV (pro) package
contents.

s For TV:
The miroVIDEO PCTV antenna input has to be connected to an antenna
or a cable TV connection. To ensure a tight fit of the antenna cable, use
the antenna adapter from the miroVIDEO PCTV package contents.
In the Select TV Country application from the miroVIDEO PCTV
program group, select the country appropriate to where you are using the
television. In doing so, the frequency range used for broadcasting in your
country is selected. (Of course, it is not possible to receive stations from
other countries using this program.)

s For Video:
 A VCR has to be connected to the miroVIDEO PCTV video input . If
the VCR supplies an S-Video signal, you can connect it directly to the S-
Video input, if your VCR supplies a composite signal, use the adapter for
composite video sources.

To watch television using the miroVIDEO PCTV board, proceed as follows:

• First, start the miroTELEVISION application from the miroVIDEO
PCTV program group.

Prerequisites
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This window lets you

s select the channel or switch to VCR operation,
s select the aspect ratio of the TV window,
s capture the current TV image (only single-frames).
s only miroVIDEO PCTV pro:

detect the reception mode (MTS, stereo, mono)
If you click the button displaying the current channel, a channel list pops up.
This list lets you select TV channels, switch from TV operation via the cable
tuner or to external video sources, e.g. a VCR. If you have connected a VCR
with a composite output to the miroVIDEO PCTV video input, select
Composite. If you have connected an S-Video VCR to the video input select
S-VHS.

Pop-up menu
When using the right mouse key to click on the miroTELEVISION window,
a pop-up menu appears which allows you to make further settings.

TV Station...
To search for the TV channels and to make the corresponding settings, first
start the Station settings dialog.

• From the pop-up menu, select the TV Station option.

Last station

Opens the
station selection
menu

Next station

Switching
the sound
on/off

Reception mode

Last station

Switching
the sound
on/off
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The Station settings dialog window appears:

Searching for all stations
To search for all stations that can be received, click All Stations.

Then, the channel names of all received stations are entered in the sender list.

The channel name is detected automatically if the channel provides teletext
information. If the channel cannot be identified, Station will be entered.

Search for next station
To search for the station with the next higher frequency, click Next Station.

Abort Search
To abort the running search process, click on Abort Search.

Quick Search
If this option is enabled, only the channels within the country-specific
frequency range are searched. If  all channels have not been found, you can
search in more detail by disabling this option. However,  this is  not
recommended, if a VCR which is connected to the antenna input is also  not
detected.

No duplicate stations
If a channel is found several times, the one transmitting the strongest signal is
selected.

Station
To overwrite the channel names in the station list with the station names,

• click on a channel name in the station list.

• Overwrite the channel name.

• Click Accept.

Adding an entry to the station list
To add an entry,

• click on the station which is located at the position in the station list
where you want to insert the new station,

• overwrite the station name and fine-tune the channel.

• Click Add.
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Deleting stations
To remove the stations from the station list,

• click on the station name in the station list.
• Click Delete.
Changing the station order
To drag a station to another position in the list,

• position the cursor on a station name in the list.

• Keep the left mouse button pressed, drag the channel to the desired
position, and release the mouse button.

Channel
Under Channel you can select channels (frequency ranges). There is not
necessarily a station broadcast on every channel. Use the arrow keys to
select the next or the previous channel. The slider under Fine Tuning lets
you fine-tune the frequency. If you want to change the channel in the
channel list, select the corresponding entry in the list, change the channel
and click Accept.

Settings...

• From the pop-up menu, select the Settings option.

The Settings dialog window appears:

• Under Color you can adjust the Saturation, the Brightness, and the
Contrast of the TV image. You can only change the Hue for NTSC.

• The options available under Standard depend on the connected video
source. For the TV function, select the video standard used in your
country, for composite and S-VHS video sources select the video
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standard  provided by the connected video source (PAL, NTSC, or
SECAM).

Default sets the image settings to mean values.

• Select the overlay type you prefer under Image.

• Under Connector, select the video source for which you want to make the
settings. Select Tuner for TV, Composite for a Composite VCR and
S-Video for an S-VHS VCR.

Audio Source
Select the sound input you want to use.

For the TV mono operation:
To improve the mono quality, you can enable the enhanced option. If the
mono reception is distorted (noise), you should disable the enhanced option.

If you installed the miroVIDEO PCTV base board, you can only select the
mono function because the tuner of the base board only provides a mono
reception.

• Select Stereo TV, if you want to use the stereo reception.

If the selected channel transmits stereo signals, the tool bar displays the
stereo reception mode:

• Select Radio if you want to listen to the radio (first you have to select a
channel with the miro radio application).

• Select CD/AUX, if you want to hear the audio device connected to the
internal audio input.

Audio Channel (miroVIDEO PCTV pro only)
If a channel broadcasts MTS, you can select whether you want to hear the
original, the dub language, or both.

• Select Channel A if you want to hear the dubbed version.

The tool bar then shows the reception mode MTS/
 first channel only /mono:

• Select Channel B if you want to hear the original version.

The tool bar then shows the reception mode MTS/
second channel only/mono:

• Select Channel A+B if you want to hear both versions simultaneously.

The tool bar then shows the reception mode MTS/
 both channels simultaneously:
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Full screen/768 x 576/384 x 288
The pop-up menu lets you choose between the image sizes Fullscreen,
768 x 576, and 384 x 288. To achieve the optimum image quality, select
768 x 576. In this case, both half frames are displayed. At a resolution of 384
x 288, only one half frame is displayed.

4:3 / 16:9
This option toggles between the 4:3 and the 16:9 aspect ratio.
4:3 is the common TV format.

X:Y
This option lets you change the width and the height of the window without
keeping the aspect ratio. When the mouse pointer turns into a double-arrow
drag the window frame to the desired size.

Cropping
When enabling Cropping, your TV image will have no black image margin.

You can make the image smaller, by clicking with the right mouse key on the
lower right corner and moving the corner so that the window will have the
desired size. You can switch the menu bar on and off by double-clicking the
right mouse key on the window.

The <F2> function key calls the context menu.

<F3> switches the task bar/menu bar on/off. The <F5> key freezes the current image.

The <F4> key stops and saves the current image  (BMP format).

miroAV-CONTROL

miroAV-Control is a tool bar offering all functions you require for using
your capture program (e. g. VidCon32).
miroAV-Control lets you select the sound inputs, the channels, the
connected video source and start the capture program (by default VidCon32
is selected).

• Start the miroAV-Control application from the miroVIDEO PCTV
program group
or
select Programs from the Start menu and the MS-DOS-Prompt. In the
DOS box, enter
mirotv32 /NOVIDEO.

Making the
image smaller

Function keys

Recording
current TV

image

Starting
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The miroAV-Control tool bar appears:

System menu
Clicking the system menu button opens the system menu:

Here you can make the settings for your windows and close the program.

When you select the Audio command, a sub-menu opens where you can
select the sound input.
When clicking the Execute ... command, a dialog appears where you can call
a capture program:

• Under Program and Directory, enter the name and the path of the capture
program you want to start (default: VidCon32).

• Mark the Autostart option if you want the selected program to start
automatically when launching miroAV-Control.

Last station

Next station

Reception mode

System menu

Opens the station selection menu

Switching the sound on/off
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miroTELETEXT (WINDOWS 95 ONLY)

Teletext cannot be received in all countries and not all channel broadcast
teletext.

To start the miroTELETEXT application, click miroTELETEXT in the
miroVIDEO PCTV program group.
If the channel you currently selected broadcasts teletext, the
miroTELETEXT main window appears and the index page is opened
automatically (page 100).

You can select teletext pages in several ways:

s Enter a three-digit page number.
s In the Teletext menu, select the Open command. Then, enter the desired

page number(s). To open several individual pages, separate the page
numbers by commas. To select subsequent pages, enter the numbers with
a hyphen.

s Keep the left mouse button pressed and drag the mouse pointer over the
page numbers shown in the teletext window. The page number to which
the mouse cursor points is highlighted. When releasing the mouse key, the
page is selected.

You can close the miroTELETEXT application by clicking the close button
in the title bar.

The main window looks the same as the one you are already familiar with
from Windows applications. At the top you find the title bar with the familiar
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icons you can use to control the windows with the default (File, Edit, and
Help) and other menus. In the icon bar you find buttons to control the
application. The status bar at the bottom of the window gives you
information about the current status or the function of the individual icons in
the icon bar.

Menus
The File menu lets you save the page of the current window to hard disk or
print it.

Save as text...
Select this command if you want to save the page as text (in the TXT
format).Enter the name and the directory of the file In the dialog window.

Save as BMP...
Select this command if you want to save the file as image. Enter the name
and the directory of the file In the dialog window,  which will then be saved
in the BMP format.

Print
To print the active page, select the Print command. The Windows 95 active
printer will be used.

The Edit menu allows you to copy teletext pages to the Windows clipboard.

Copy as TXT
Select this command to copy the current page as text. You can use a word
processing program (e. g. the Windows text editor) to edit the teletext page
contents.

Copy as BMP
Select this command to copy the current page as image.

Open
To open one or several pages, select the Open command. Enter the desired
page number (it appears in the status bar) and click OK. Individual pages are
separated by a comma, subsequent pages are entered with a hyphen
(e. g.: 101-105, 107). When calling up several pages, the Multiple page
windows option will be enabled automatically, see also Options menu.

Index
This command opens the index page 100.

Previous
With this command you start the previous page.

Next
This command opens the next page.

Next block page
This command calls up the next page terminating with a number of 10. If e.g.
page 501 is currently active, miroTELETEXT will jump to page 510.

Next group page
This command calls up the next page terminating with a number of 00. If e.g.
page 501 is currently active, miroTELETEXT will jump to page 600.

Previous/Next sub-page
One teletext page can include several sub-pages, the miroTELETEXT
software will automatically browse through the sub-pages. If sub-pages have
already been received, you can browse through these pages using the

File

Edit

Teletext
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corresponding menu items. Automatic updating of sub-pages will be
stopped. Further incoming sub-pages will be registered in the background
and existing sub-pages will be updated.

Example: In the title bar 6/2 appears, that means that 6 pages have been
transmitted already and that you are viewing  page 2 .

Browse sub-pages automatically:
If one teletext page consists of several sub-pages, every new sub-page is
automatically displayed. The Browse sub-pages automatically item is marked
with a [, by default. If you want to display a sub-page longer, you can stop
the browse function by clicking on this menu item. Clicking it again, switches
the browse function back on again.

Multiple page windows
To work with several windows, click this command. Clicking the command
again, disables this function.

Show hidden text
On some teletext pages information is hidden, e.g. solutions for TV quizzes.
To show this information, enable the Show hidden text menu item.

Previous/next channel
To view teletext pages of the previous or the next channel, click the
corresponding menu item.

Channel...
This menu item lets you call the channel dialog containing the list with
existing channels.

Switching the channels is only possible when miroTELEVISION is active. In
the multipage mode, pages from different channels with the same page
number can be displayed simultaneously: a new window is created and is
displayed simultaneously with the one which is currently open. In the single-
page mode the window which is currently active will be updated when
switching to another channel.

In the Window menu you will find options allowing you to arrange the
windows:

Cascade
The windows will be arranged so that they overlap.

Arrange icons
The minimized windows will be arranged in the task bar.

Close all
All windows will beclosed.

Minimize all
All windows will be minimized to icon size.

Options

Windows
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miroTELETEXT icon bar
The icon bar allows you to directly access frequently used commands:

Call next page terminating with 100

Save as ... text/image

Open teletext page

Print current page

Calling previous sub-page

Calling index page 100

Calling previous page

Calling next page

Call next page terminating with 10

Show hidden text

Calling next sub-page

Multiple page windows

Enabling/disabling browsing through sub-pages

Searching text
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miroRADIO (ONLY WINDOWS 95)
This application features a FM Radio with stereo capabilities.

To start the miroRADIO application, click miroRADIO in the
miroVIDEO PCTV program group. The miroRADIO main window will
appear:

Station
Here the current channel and frequency will be displayed.

 lets you select the subsequent channel from the channel list.

 lets you select the previous channel from the channel list.

Sound
This group box enables you to control the stereo/mono signal. You can use
the slider to set the appropriate audio volume, if you installed a sound board
in your system and the external miroVIDEO PCTV audio output has been
connected to the Line-In input of the sound board.

The installation program checks if a sound board has been installed. If this is
not the case, you cannot control the volume.

 mutes/unmutes audio output

 toggles between the stereo and the mono signal.

Record

Click on the  button to start recording, the following window will
appear.
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Clicking Stop recording aborts recording immediately.

If you do not abort recording manually, the process stops automatically when
the predefined time-out (see radio configuration below) value has been
reached.

Playback

The last recorded audio sequence can be played back using the  button.
Audio output will switch from radio to wav. The station fields will show the
file currently playing. Use the volume slider to control audio output volume.
The playback can be stopped at any time.

Use the  button to select and play a file from the miroRADIO record
folder. The dialog field Open will show a list of wav files recorded with
miroRADIO. Selecting a file will start playing.

Recording and playing back is only possible when a sound board is installed
in your system which has been configured by the miroRADIO application. If
the sound board configuration did not succeed or if no board has been
installed, the controls are grey.

Favourites
Use these buttons to call pre-programmed channels. Pre-programming
channels is done via the radio configuration.

Configuring the miroRADIO application
When clicking Properties under Configure a configuration dialog appears
with the Station list and Recording tabs.
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After starting the program for the first time, the application searches for
channels and shows all found channels and their frequency in a list.

Editing station list
You can edit the station name at any time, to change the frequency, however,
use the fine-tune slider. To edit a name, select the entry and change it.

Select a station and press the <Insert> key to add a new station. It is then
added to the end of the list. Enter the desired frequency which must lie
between 87.50 MHz and 108.00 MHz. The frequency is then added to the
frequency column and the station name is entered automatically.

To delete a station, select it and press the <Del> key.

To delete several stations, keep the <Strg> key pressed, select the
subsequent stations and press the <Del> key.

To put a station to another position in the list, use the mouse to point to the
station list. Keep the left mouse button pressed and drag the channel to the
desired position, release the mouse key.

Edit station the
name

Adding stations

Deleting a
station

Re-position the
station
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Mark a channel and click one of the station keys:

After a complete search process, the station keys are no longer allocated.

The All button starts a new channel search. The existing list will be deleted.
The channels are searched with the selected Scan sensitivity (see below).

The Next button searches the channel with the next-higher frequency. If the
channel which has been found is not included in the list, it will be added to
the end of the list.

Under Scan sensitivity you can adjust the sensitivity used for searching the
channels. You can choose among 4 quality levels:

s best: the scan routine will accept stations with the best signal strength
s high: the scan routine will accept stations with high signal strength
s medium: scan routine will accept stations with medium signal strength
s low: scan routine will accept stations with low signal strength
Select the desired level and click All.

The Fine tuning slider lets you adjust the frequency of the channel you
currently selected within ± 50 kHz.

Closing the dialog
When clicking OK all settings are accepted and saved. The window will be
closed.

Clicking Cancel rejects the settings and the window will be closed.

Configuring the recording parameters
The Recording tab lets you select the recording parameters:

Favorites/
Allocating

stations to the
keys

Channel search

Search next
channel

Setting the scan
sensitivity

Fine tuning
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Here you can,

s select the recording quality choosing the CD, Radio or Telephone
parameters,

s adjust the pitch for the recording (in %),
s select the maximum recording time (after this time has expired, recording

is aborted),
s specify the remaining memory you want to be available after recording,
s enter the path and the directory where you want to save the file.

The Default button sets all parameters to default values.

CAPTURING VIDEO WITH VIDCON32
To capture AVI files we recommend using VidCon32 This program has been
copied into your Windows directory and into the Windows Start menu.

Click on VidCon32 in the miroVIDEO PCTV program group. The
VidCon32 main window appears. The icon bar includes the following
buttons:

Starting

Selecting the preview mode

Selecting the overlay

Recording a single-frame

Recording the video clip

Calling the Properties dialog

Playing back video

Capturing video
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The “Tricks & Tips” chapter gives you more helpful tips on how to use
VidCon32 (see chapter 7).

To record video sequences, please proceed as follows:

1. Switch on the video source.

2. If you connected a VCR to your board, search for the beginning of the
video clip you want to play back and press Pause.

3. Start VidCon32.exe from the Windows Start menu.

4. From the Options menu select the Video Source dialog box.

You will find a detailed description of the Video Source dialog box under
„Settings in VidCon32“ (see page 38).

5. Change the settings if required.

6. From the Options menu, select the Video Format dialog box.
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7. Please make the following settings:

• Adjust the image size under Image Dimensions. The options vary
depending on the video standard. Please also refer to the table on page
39.

• Select the format for displaying and capturing under Image Format.
For detailed information, refer to the table on page 39.

8. If you have a sound board installed in your computer and you also want to
digitize the audio signal:

• Select Options and Audio Format. Make the desired settings.

9. In the File menu call Set Capture File.

• Create a file to which VidCon32 copies the incoming data.

When creating a new file, the Set File Size window appears
automatically.

• Specify a sufficient file size under Set File Size.

In this way, you make sure that a clip is saved to the hard disk in one
piece (without being fragmented). This setting reserves a sufficiently
large area on the hard disk.

10.Select Capture / Video to get the CaptureSetup dialogue box.

11.Please select the following settings:

• Select either Directly to disk or Capture to memory.

For large video clips the best results are achieved by selecting the Directly to
disk option.
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• If necessary, enable the Enable Capture time limit option and
determine how long you want the digitizing process to take. After the
predefined time VidCon32 stops capturing.

• Specify the frame rate:
For PAL and SECAM, select 25 fps. For NTSC, select 30 fps.

• If you want to compress captured video sequences, click Compression,
select a suitable compression method and select the compression
quality.

• If you have a sound board installed in your computer and you also
want to digitize the audio signal, enable the Capture Audio option.

• The Audio Format button lets you specify the desired audio format and
determine the name of the audio file.

12.Click OK to close the windows.

13.If you connected a VCR, start playing the video clip now.

14.Click the Record button to start capturing video.

15.Press the right mouse button to finish capturing.

If you do not do so, the board stops capturing after the time limit you
specified in the Capture Video Sequence dialog box.

16.In the File menu select the Save captured Video as... command.

17.Save the file under another name and, if necessary, in another directory.

RECORDING SINGLE FRAMES WITH VIDCON32
Proceed as follows to make single frames rather than a video sequence:

1.  Switch on the video source.

2. Start VidCon32 from the Windows Start menu.

3. Select the Options menu and the Video Source command.

4. Select the Options menu and the Video Format command.
Make the settings in the Video Format window as described on page 34.

5. If you connected the VCR, start the desired video clip now.

6. Select Single Frame from the Capture menu or click the Record button 
for capturing single-frames.

7. Select the Save Single Frame command from the File menu.

8. Specify the desired drive, directory, and file name, then click OK.
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Tips & tricks

This chapter gives you important hints and tips & tricks for the
miroVIDEO PCTV (pro) board.

HARDWARE REQUIREMENTS

The hardware requirements depend on how you want to use the
miroVIDEO PCTV (pro) board.

• Computer:
If you only want to use the TV functionality of the miroVIDEO PCTV
(pro) board, a less powerful computer is sufficient. If you want to use the
full function range of the board and want to capture video clips, you need
powerful hardware, that is a fast computer (Pentium) and a fast hard disk.

• Hard disk:
If the hard disk works too slow, the PC cannot save the digitized images
fast enough and the drop-out rate increases. The drop-out rate is the
number of images which are not saved during capturing. This results in
jerky playback. Your hard disk should offer a transfer rate of 3
Mbytes/sec under Windows.
If your hard disk is too slow to save all images, either select a smaller
image format or lower the frame rate to e.g. 15 fps.

• Partitioning the hard disk:
You can reserve a hard disk or a partition of the hard disk exclusively for
digitizing video clips.

• Defragmenting your hard disk:
Usually, the hard disk is searched for free spaces. If a hard disk is in use
for some time, the files are fragmented and saved in different segments of
the disk. During the digitising process the hard disk tries to fill the free
gaps. This increases the access time and the drop-out rate. In this way
some images are missing and the video playback is jerky. After
defragmentation the images are saved on a contiguous segment. For this
purpose, Windows 95 offers the Defrag tool.

• Memory:
In general one can say that the more memory available, the better the
capturing capabilities are.

• Screensaver/TSR programs:
Switch the screensaver and the TSR programs off. These can disturb the
capturing process.

• Requirements of the video source:
If you can choose between the composite and the S-Video input, use the
S-Video input for quality reasons.
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INSTALLING miroVIDEO PCTV (PRO)
To enable busmastering with the miroVIDEO PCTV (pro) board, your
motherboard must support the PCI bus revision as of 2.1. This is not the case
for older 486 boards and some Pentium boards with the Intel P60/66.

Combining the miroVIDEO PCTV (pro) board with graphics boards
containing an S3 Vision868 or 968 graphics processor may cause system
crashes after starting the miroTELEVISION application. The processor of
the graphics board causes a memory conflict, if the system allocated the
miroVIDEO PCTV (pro) memory area directly behind the graphics board´s
memory area.

Although the memory areas do not seem to overlap, a conflict may occur
because the S3 Vision 868 and the 968 processor need a larger memory area
than the one entered in the Device Manager so that it may happen that the
graphics driver accesses the memory area of the miroVIDEO PCTV (pro).
To view the memory addresses, proceed as follows:

1. If you have not done so already, start Windows 95.

2. From the Start menu, select Settings and the Control Panel.

3. Select System, the Device Manager tab and the Properties button.

4. Select the Memory option.

5. Go to the end of the list.

In this example the last address of the graphics board (F3FFFFFF) is located
directly before the miroVIDEO PCTV start address (F4000000). Please
make a note of the starting and the ending addresses of your graphics and
your miroVIDEO PCTV board (starting address: left-hand side, ending
address: right-hand side).

The following tells you how to change the miroVIDEO PCTV (pro) address
range manually:

1. Click OK to go back to the Device Manager.

PCI revision as
of 2.1

Problems with
graphics boards
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2. Select the Audio, Video and Game Controller icon.

3. Double-click miroVIDEO PCTV (pro) and select the Resources tab.

4. Disable Use automatic settings.

5. Mark the Memory Range.

6. Click Change setting.

7. Add 04000000 h to the memory range of your graphics board (example:
F0000000 h + 04000000 h = F4000000 h)*.

8. Enter the value you calculated (e. g. F4000000 h) as miroVIDEO PCTV
starting address.

9. Enter the starting address as ending address and replace the three zeros by
FFF (e. g.: F4000FFF h).

8. Click OK and restart Windows.

SETTINGS IN VIDCON32

Video Source settings
Overlay

s Force Preview:
When you selected Force Preview, the video image will be displayed in
the preview mode. In this mode, the video data will be transferred first
to the main memory of the computer. From there the data is
transmitted at fixed time intervals to the graphics board memory.
The advantage of this mode is that it is compatible with any standard
VGA board. The disadvantage is that the image quality may be limited
depending on the number of colors. The video sequence will not be
displayed in real-time, that means that only a few images per second
are displayed.

s Use Primary:
The Primary mode is a kind of Overlay mode and is in some cases
better than the Overlay mode. Here the miroVIDEO PCTV board
takes on the scaling of the displayed image. For this purpose, the video
data is transferred directly to the video memory of the graphics board.
Which sizes are available depends on the video standard of the input
signal.
The advantage of this setting is the optimal image quality of  16/32-bit
resolution (16.7 million colors) while disturbing effects are avoided.
With 8-bit resolution the color transitions are not smooth due to the
limited number of colors.

s Use Overlay:
In the Overlay mode the graphics board scales the images. The video
data is transferred into the the part of the graphics board´s memory
which is not used for displaying graphics data. The graphics board
processor displays the video signal supplied by the miroVIDEO PCTV

                                                       
*  To calculate the addresses, use the Calculator from the Windows Accessories folder: In the View menu, select the

Scientific mode. Then, select the Hex(acedimal) mode.
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board. You can also change the image size by selecting a different
video format.
If the graphics board is equipped with sufficient memory, the full-
screen mode is possible. Independently of the number of colors you
selected for your graphics board, the overlay appears in real colors.

The settings you make in the Video Source window under Overlay only
influence the displayed overlay but not the captured video.

Video Format settings
Image Dimensions
The following table explains the relationship between the selected video
standard and the available resolutions:

NTSC PAL/SECAM
1/4 160 x 120 pixels 192 x 142 pixels
1/2 320 x 240 pixels 384 x 284 pixels
Full 640 x 480 pixels 768 x 576 pixels

360 x 240 pixels (CCIR601) 160 x 120 pixels
240 x 180 pixels 240 x 180 pixels

320 x 240 pixels
360 x 288 pixels (CCIR601)
640 x 480 pixels
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Image Format
The following table explains the individual settings:

Setting BPP (bit
per pixel)

Explanation

Y8 8 This format uses only the brightness information,
corresponds to 8 bits in grey scales.

YUV9 9 Suitable for capturing video clips which you want to
compress later using an Indeo41-Codec.
Advantage: During capturing a comparatively low amount
of data is produced.
(The brightness value is taken from each pixel, the color
value is calculated from the mean color value of 9 pixels
forming a square.)

BTYUV 12 Corresponds to the YUV411 format, supplies a higher
quality than YUV9 but creates approximately 33% more
data.
(One color value is allocated to 4 pixels with in a line.)

YUV12 12 Suited for capturing video clips which you want to
compress later using an MPEG format.
This format provides an optimal image quality at relatively
low data rates.
(At this format one brightness and one color value is used
for 4 pixels (arranged in a square).

15 bit RGB 15 Windows standard graphics format.
Suited for capturing video clips and single-frames which
can be played back on any system without additional
hardware and software.
This format offers a good image quality but produces on
the other hand a medium amount of data.

YUY2 16 Especially high-quality capturing format which nearly
provides the quality of a TrueColor file (24 bit RGB), the
resulting amount of data is relatively small.
Is especially suited for capturing video clips in the CinePak
format.
(From 2 pixels 1 color value is taken.)

24 bit RGB 24 Windows standard graphics format. Recommended for
capturing single-frames which you want to edit later.

32 bit RGBA 32 Corresponds to 24 bit RGB. Recommended for capturing
single-frames which you want to edit later.
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Capture format and data rate
The following table gives you an overview over the different capture formats
and the data rates which are produced during capturing.

The data rates have been measured when capturing video files (AVI) without
compression and sound.
For the 768 x 576 and the 640 x 480 resolutions you can only capturing is
only possible in the Preview mode.

Capture format Video standard Resolution Frames/sec.
Data rate

(Mbytes/sec.)
192 x 142 1,3

15 bit RGB/YUY2 PAL/SECAM 384 x 284 25 5,5
768 x 576 22,1

(16 Bit) 160 x 120 1,1
NTSC 320 x 240 30 4,5

640 x 480 18
192 x 142 0,8

15 bit RGB/YUY2 PAL/SECAM 384 x 284 3,2
768 x 576 15 12,8

(16 Bit) 160 x 120 0,6
NTSC 320 x 240 2,3

640 x 480 9
192 x 142 1

BTYUV PAL/SECAM 384 x 284 25 4
768 x 576 16

(12 Bit) 160 x 120 0,8
NTSC 320 x 240 30 3,4

640 x 480 13,5
192 x 142 0,6

BTYUV PAL/SECAM 384 x 284 2,4
768 x 576 15 9,6

(12 Bit) 160 x 120 0,4
NTSC 320 x 240 1,7

640 x 480 6,8
192 x 142   -

YUV9 PAL/SECAM 384 x 284 25 3
768 x 576 no preview

(9 Bit) 160 x 120 0,5
NTSC 320 x 240 30 2,1

640 x 480 15
192 x 142  -

YUV9 PAL/SECAM 384 x 284 1,8
768 x 576 15 no preview

(9 Bit) 160 x 120 0,3
NTSC 320 x 240 1

640 x 480 7,5
192 x 142 2

24 bit RGB PAL/SECAM 384 x 284 25 8
768 x 576 32

(24 Bit) 160 x 120 1,7
NTSC 320 x 240 30 6,8

640 x 480 27
192 x 142 1,2

24 bit RGB PAL/SECAM 384 x 284 7,5
768 x 576 15 19

(24 Bit) 160 x 120 0,8
NTSC 320 x 240 3,4

640 x 480 13,5
192 x 142 2,7

32 bit RGB PAL/SECAM 384 x 284 25 10,7
768 x 576 42,6

(32 Bit) 160 x 120 2,3
NTSC 320 x 240 30 9

640 x 480 36
192 x 142 1,6

32 bit RGB PAL/SECAM 384 x 284 6,4
768 x 576 15 25,6

(32 Bit) 160 x 120 1,1
NTSC 320 x 240 4,5

640 x 480 18
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Settings in the Capture Video Sequence window
Saving data on the hard disk/in the memory:
Usually, video is directly stored on the hard disk. This process takes up very
much space on the hard disk, on the other hand no processor performance is
used for converting and compressing data and it is possible to take full
advantage of the hard disk´s performance.
If it is not possible to capture a video clip with drop-out rates of under 20%
although you tried out different settings, do not save the data directly on the
hard disk but in the memory. To be able to do so the computer has to have at
least 16 Mbytes of RAM. You will find a table with the amount of data on
page 41.

VidCon and file name extensions:
If you create a capture file using the File menu and enter a new file name, we
recommend to add the extensions (AVI for video clips, DIB or BMP for
single-frames). VidCon32 does not add these automatically.

Determining the file size:
If you choose the VidCon32 File menu and select the Set Capture File
dialog box, create the file in which you want VidCon32 to save the incoming
data. If you create a new file, you will be automatically asked how much
memory you want to reserve on the hard disk.

This size is not equal to the final file size of the AVI file. It only serves as
buffer for uncompressed video.

Create a sufficiently large file. If you select a value which is too low for the
file size, VidCon32 automatically sets the file size to the required value. If
you select a file size which is too high, you might possibly waste disk space.
You can solve this problem by saving the file again under another name.

VidCon32 can always access this disk space. Please check the file space time
after time via the Allocate file Space item in the File menu.

You can avoid that the file size increases without being able to control it by

s creating a capture file via the File menu and the Set Capture File
command,

s reserve a file size of 1 Mbyte,
s save the file under another file name, if necessary, in another directory,
s capture the next video clip in a capture file and save it again under another

file name, and so on.

In this way, you make sure that VidCon32 always accesses the space on the
hard disk you reserved.
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Three examples for capturing video clips
To illustrate the relationship between the image size and the frame rate, we
chose three typical examples:

Capturing a video clip in full size (768 x 576)
When capturing images in the full image size, high amounts of data occur per
single-frame. The number of images which can be recorded per second is
low.
Depending on the color depth you selected, amounts of data of 500 KB up to
1.4 Mbytes occur per image (uncompressed). Therefore it is recommended
to select a lower frame rate (1 to 3 frames per second).
Depending on the format 1.5 up to 4 Mbytes per second are created.

You should select an RGB color (15, 16, or 24 bit) or YUY2 format. In your
capture program the preview mode must be selected.

Recording a video clip with the full frame rate (25 or 30 frames per
second)
Even at a compact video format such as YUV9 data rates of up to 3 Mbytes
per second occur (uncompressed) (see also table on 41).

It is recommended to reduce the resolution:
under NTSC e. g. 320 x 240 (30 frames per second),
under PAL e. g. 384 x 288 (25 frames per second).

Using software compressors (Codecs) allows to reduce the amount of data
to 400 Kbytes per second while the image quality remains the same. For this
purpose, you need a powerful computer (at least a Pentium 133 computer).

Partly, the Codecs will be accelerated by the MMX* architecture.
The capture performance can be improved considerably under PAL at a
reduced resolution (e. g. 320 x 240) because of the lower amount of data and
because the Codecs can work more efficiently with this format.

Capturing a sequence in the 240 x 180 format at 25 or 30 frames per
second (very small videos)
For these videos, compressors are required which are used for video
conferencing (e. g. H.263). With these compressors you can achieve 50 KB
per seconds. Such compressors are supplied with video conferencing
software. If required, you can also use another Codec, e. g. YUV9 with
Indeo Video interactive Codec (then the data rates are higher).

                                                       
*  Intels Multimedia Extensions: Additional commands of the microprocessor accelerating mulitmedia

applications.

Example 1

Example 2

Example 3
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Technical data

miroVIDEO PCTV
PCI

Brooktree Bt848

ITT VPX3220

Depending on the delivery scope;
corresponds to tuner standards:

Country specific versions
D, A, CH, DK, NLPAL B/G tuner 48.25 - 855.25 MHz
UK PAL I tuner 45.75 - 855.25 MHz
F SECAM tuner 45.75 - 855.25 MHz
US NTSC tuner 48.25 - 855.25 MHz

S-Video input, Composite video input

Audio output

75 ohms IEC adapter (Europa), F connector (USA)

s miroTELEVISION/miroAV-Control (application for selecting channels;
only for Europe)

s miroTELETEXT (teletext application)
s miroRADIO (radio application)
s VidCon32

miroVIDEO PCTV pro upgrade
s Add-on board for miroVIDEO PCTV
s Antenna connector with 75 ohms via IEC connector
s Stereo audio decoder:

Country-specific versions

EU
CCIR stereo audio decoder using 
dual carrier method

US BTSC stereo audio decoder

GB
Stereo audio decoder for Nicam I 
and Nicam B/G

Bus system

Video decoder

VideoDecoder

TV tuner

Video Inputs

Output

Antenna input
Software

Hardware
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Appendix

IDENTIFYING THE WINDOWS 95 VERSION

To identify the installed Winows 95 version, you have to start the MS-DOS
Prompt.

1. In the Start menu, select the Programs command and the
MS-DOS Prompt.

2. In the MS-DOS Prompt window type ver, and press <Enter>.

The installed Windows 95 version will be displayed.

The Windows 95 OSR 2 (OEM-Service-Release 2) version has the
version number Windows 95. [Version 4.00.1111]; the August Windows
95 Release has the version number Windows 95. [Version 4.00.950].

3. Close the MS-DOS Prompt.
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INTERNAL CONNECTORS

Depending on the board type, the miroVIDEO PCTV base board includes up
to 5 internal connectors (ST1, ST6, ST7, ST8, ST9) you can use to attach
other boards with internal connectors (e.g. video capture boards).
ST1 is occupied by the miroVIDEO PCTV pro upgrade.

miroVIDEO PCTV: Internal connectors

ST1 = Combined audio/video expansion connector

ST6 = Internal Audio input

ST7 = Internal Audio output

ST8 = Internal TV output

ST9 = Internal I2C Port
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The following table shows the corresponding pin assignments.

Designation Pin Assignment Significance

ST1 1 = +5V

2 = Audio Left Input

3 = +12V

4 = Audio Right Input

5 = GND

6 = SDA

7 = D9

8 = SCL

9 = D8

10 = D2

11 = D19

12 = D5

13 = D20

14 = D6

15 = D21/Reset

16 = D7

17 = GND

18 = D18

19 = -12V

20 = D17

21 = TV FBAS

22 = D16

23 = TV Audio

24 = D15

25 = TV Basisband

26 = D14

Combined audio/video expansion
connector

ST6 1 = Left

2 = GND

3 = GND

4 = Right

Internal Audio input (separate
Audio input for connecting
additional analog audio signals (e.g.
CD-ROM)

ST7 1 = Left

2 = GND

3 = GND

4 = Right

Internal Audio output

ST8 1 = FBAS

2 = GND
Internal TV output for the
connection of a miroVIDEO DC10/
miroVIDEO DC30 board

ST9 1 = SDA

2 = GND

3 = SCL

Internal I2C Port
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SUPPORTED GRAPHICS BOARDS

A graphics board which has to run togehter with the miroVIDEO PCTV
(pro), has to support DirectDraw and Video overlay under Windows 95. To
ensure the best performance, the graphics board has to be equipped with 2
Mbytes of memory.

In the following graphics boards are listed which have been tested
successfully with the miroVIDEO PCTV board:

s boards with a S3 TRIO 64V+- or S3 ViRGE graphics processor, i. e.:
s miroVIDEO View

s miroVIDEO 3D

s miroVIDEO 22SD

s VT and GT series by ATI (MACH64 graphics processor)

s boards with Cirrus Logic 5446 graphics processor

s boards with Tseng ET6000 graphics processor

s Matrox MGA Millenium and Mystique

s miroCRYSTAL VRX

s miroCRYSTAL VR 2000/4000

s miroCRYSTAL DVD.
If you have problems with graphics boards, read the “Problems with graphics
boards” section under “Tips & Tricks” on page 37.
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GLOSSARY

This glossary contains the most important concepts from the field of
computer hardware, software and video. Cross-references are marked by this
symbol &.

All memory positions in a computer have numbers (addresses). Through
these addresses each memory position can be addressed. Some addresses are
reserved for certain & hardware components and must not be used. If two
hardware components use the same address, there is an address conflict.

American National Standards Institute. ANSI character set (& Font): used
by Microsoft Windows and Windows applications. The character assignation
only differs slightly from the assignation of the & ASCII character set.

American Standards Committee of Information Interchange. ASCII
character set (& Font): standard character set used by IBM and compatible
computers. The ASCII character set consists of 256 characters, the first 128
of which are standardized.

A special DOS & batch file which is processed automatically after the
computer has been started. The file contains among other things commands
which load the country-specific keyboard driver (& Driver) or load
programs automatically.

Abbreviation for Audio Video Interleaved, standard format for digital video
(& Video for Windows).

A & DOS file where a sequence of commands is processed one after the
other.

Basic Input Output System. Number of basic input and output commands
stored in a & ROM, PROM or EPROM. The & operating system uses
these commands. The basic task of the BIOS is to control the data input and
output. After starting the system the ROM BIOS performs some tests
(checking the & interfaces, the disk drives, etc.).

Binary Digit. Smallest information unit in a computer. One bit can take on
two states: “0” and “1”, two bits can take on 22=4 states and three bits
23=8, etc. In a computer those states are realized by “0 V” (no current = 0)
and “5 V” (current = 1). To display a character (letter, number etc.), 8 bits =
1 & byte are required.

In a computer, the bus provides for the communication between the &
processor and the installed hardware (hard disk, graphics board, etc.).
Depending on the bus width, the bus transfers a different amount of
information. An 8-bit bus can transfer 8 & bits (= & byte = one character)
at a time.

One byte consists of eight & bits. One byte represents exactly one character
(letter, number etc.). The characters are binary-coded with “zero” (0) and
“one” (1). The character “E” has the & ASCII code “01000101” or “45h”
(hexadecimal).

A & CD-ROM standard designed for the field of entertainment which is
independent of and not compatible with the conventional CD-ROM standard.
Interactive components (e.g. for games) can only be played back with an
original CD-I playback device.

Aa - Fr

Pi - U
w

Je - Ph

Address

ANSI

ASCII

AUTOEXEC.BAT

AVI

Batch file

BIOS

Bit

Bus

Byte

CD-I
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CD-ROMs are mass storage media for digital data, such as & digital video.
CD-ROMs can only be read.

Color Graphics Adapter (IBM). Graphics board which displays four colors
in the graphics mode.

Rate at which individual commands are processed in a processor. The higher
the & clock frequency, the quicker the commands are processed.

Color Look Up Table. Color table which contains all indexed color values.

Acronym for Compressor/Decompressor, compresses (packs) and
decompresses (unpacks) image data.

Number of & bits containing color information for each & pixel. A color
depth of 1 bit displays only black and white (21=2 colors). At a color depth
of 8 bits 28=256 colors are available and at 24 bits 224=16,777,216
(& TrueColor) colors are available.

Composite video encodes all image information in one signal.

A & DOS configuration file which is processed automatically when the
system starts. The CONFIG.SYS file includes & drivers which control the
output to the monitor and the keyboard and the mouse.

Data per second, e.g. amount of data which a mass storage medium (hard
disk or CD-ROM) saves/plays back per second or the amount of data of a
video sequence per second.

Digital video stores information bit by bit in a file (in contrast to analog
storage media).

A software interface developed by Microsoft for 3D games and other 3D
applications under Windows 95. Enables Direct3D-capable applications to
access 3D hardware efficiently.

Software interface developed by Microsoft for Windows 95 which enables
applications to access the graphics hardware.

Successor of Video for Windows for Windows95. Has been expanded by
Microsoft and will be designated by ActiveMovie in future.

Direct (X) Extensions is a collection of several system extensions developed
by Microsoft for Windows 95 (among others & DirectDraw, & Direct3D),
to enable video and games acceleration.

Dual Inline Package switch. A row of small switches designed to make
certain hardware presettings.

Method to avoid extreme color contrasts, which occur with a reduced
number of colors.

Disk Operating System. The most common & operating system for PCs
(Personal Computer). MS DOS is the Microsoft version of DOS.

Programs which integrate the hardware (e.g. driver for a CD-ROM drive) in
the computer and which adapt the software to the hardware (e.g. driver for a
graphical user interface, such as Microsoft Windows). The software then
uses the features of the graphics board.

E(xtended) D(ata) O(ut)-DRAM is a new, significantly faster variant of
DRAM.

Enhanced Graphics Adapter (IBM), graphics board which displays 16 colors
in the graphics mode.

CD-ROM

CGA

Clock frequency

CLUT

CODEC

Color depth

Composite video

CONFIG.SYS

Data rate

Digital video

Direct3D

DirectDraw

DirectVideo

DirectX

DIP switch

Dithering

DOS

Driver

EDO-DRAM

EGA
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Extended Industry Standard Architecture. 32-bit bus: The EISA bus can
transfer an amount of data of 33 & Mbytes per second at a & clock
frequency of 8.33 Mhz.

Monitor operating at a very small frequency range (& multifrequency
monitor).

Character set in a certain type, size and style, e.g. Times New Roman 11,
normal; Times New Roman 11, italics; Times New Roman 11, bold; Times
New Roman 11, bold, italics.

Image rate measured in frames per second when capturing and recording
video clips.

Graphics boards are the “link” between the computer and the monitor.
Without a graphics board no image appears on the screen. Graphics boards
operate in two modes: the text mode and the graphics mode. In the text
mode only & ASCII characters are displayed. The ASCII character set
includes some simple “graphical” characters to display simple graphics. The
graphics mode uses individual & pixels. The more pixels available (the
higher the & resolution) the more detailed characters and graphics can be
displayed.

The hardware includes all computer components which are “hard”, such as
the monitor, the hard disk, the keyboard, the mouse and the printer.

Hercules Graphics Card, monochrome (black and white) graphics board.

Number of horizontal scans of the electron beam per second required to
create a new line. The higher the & resolution the higher the required
horizontal scan rate.

The designation “Intercast” is composed of Internet and broadcast. With
Intercast, internet pages are linked to TV programs. In the USA some big
TV stations broadcast Internet pages for free.

Link between two parts of a system or between two systems where
information, pulses and signals are adapted in a way that the receiving part
can understand the sending part. For example, signals which the computer
sends to the printer have to be adapted by an interface so that the printer
“understands” what it has to print.

Image refreshing technique: the screen is subdivided into lines. When
refreshing the image first all even lines and then all odd lines are refreshed.

International Standard Architecture. 16-bit bus which transfers 8 & Mbytes
of data per second at a & clock frequency of 8 MHz.

Jumpers can set up or interrupt electrical leads. To establish electrical leads
with a jumper, the jumper has to be mounted, to interrupt the lead the jumper
has to be removed.

1 KB (Kilobyte) is equal to 1024 & bytes. Here “K” (kilo) is always equal
to “1024”.

1 Mbytes (Megabyte) equals 1024 & KB.

Monochrome Display Adapter. Monochrome (black and white) graphics
board.

Abbreviation for Motion Pictures Experts Group. Standard for the
compression of moving images.

EISA bus

Fixed-frequency
monitor

Font

Frame Rate

Graphics board

Hardware

HGC

Horizontal scan
rate

Intercast

Interface

Interlaced

ISA bus

Jumper

KB

Mbytes

MDA

MPEG
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A multifrequency monitor adapts itself automatically to different frequencies
supplied by the graphics board (& fixed-frequency monitor) and can display
different & resolutions.

NICAM is a digital transmission method for audio signals in the TV
technology.

Image refresh method, where the complete image is generated without
skipping lines. A non-interlaced image flickers much less than an &
interlaced image.

Abbreviation for National Television System Committee.

Color TV standard spread in the USA using 525 lines and 60 image fields per
second.

The operating system provides for the communication between & hardware,
& software and the user. The tasks of the operating system are among
others the file and the program management.

Abbreviation for Phase Alternation Line. Color TV standard developed in
Germany using 625 lines and 50 image fields per seconds.

The parallel or Centronics & interface transfers data through an 8-bit data
line. This means that 8 & bits (1 & byte) can be transferred at a time. The
transfer through the parallel interface is considerably faster than the transfer
through the & serial interface, over long distances the parallel data transfer
is, however, more susceptible to interference. Parallel interfaces are
designated by LPT and a number (e.g. LPT1).

Peripheral Component Interconnect. Local Bus concept by Intel: 32-bit bus,
a PCI bus can transfer 132 Mbytes per second (max.) at a & clock
frequency of 33 MHz.

Picture element. Pixels are the smallest elements of a monitor image (&
resolution).

Rate at which the pixels appear on the screen.

The TV image appears on the monitor with the number of colors the
graphics board supplies and possibly not in full size. See also & TV overlay.

Random Access Memory. A RAM is a read-write memory component from
which data can be read and to which data can be written any time. The
computer memory is equipped with RAM components. The memory is a so-
called “volatile” memory meaning that the memory contents are removed as
soon as the computer is switched off.

Also vertical scan rate. Number of image refreshes per second measured in
Hertz (Hz). The higher the vertical scan rate the less flicker.

Number of & horizontal and vertical pixels. 1408 x 1024 means that 1408
pixels are displayed horizontally and 1024 pixels are displayed on the
monitor vertically.

The higher the resolution the more details the monitor can display.

Abbreviation for Red, Green and Blue, the basic colors of additive color
mixing. RGB describes the method used in computer technology where
image information is transferred by dividing it into the three basic colors.

Multifrequency
monitor

NICAM

Non-interlaced

NTSC

Operating
system

PAL

Parallel
interface

PCI Local Bus

Pixel

Pixel frequency
Preview

RAM

Refresh rate

Resolution

RGB
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Read Only Memory. A ROM is a memory component which can only be
read but which cannot be modified. The ROM's contents remain in the
component also after the computer has been switched off. All functions
which have to be available immediately after switching the computer on, e.g.
the data for the system test, the character output on the screen, etc. are
stored in ROM components. There are also PROMs (Programmable ROM)
EPROMs (Erasable PROM) and EEPROMs (Electric EPROM).

Adaptation of an image to a different size.

Abbreviation for Séquentiel Couleur à Mémoire. Color television system
developed on the basis of the & NTSC system operating with 625 lines and
50 image halves per second.

Also RS232. The serial interface transfers data through a data line bit by bit
(all & bits of a & byte one after the other). The serial data transfer is
considerably slower than the transfer through the & parallel interface but it
is less susceptible to interference. Serial interfaces are designated by COM
and a number (e.g. COM1).

General term for all programs a computer can run (system programs,
application programs, & drivers etc.) and files.

Improved standard for home VCRs using S-Video signals to improve the
color reproduction (& Y/C).

With S-Video signals the brightness (luminance) and the color information
(chrominance) are transferred separately.

16.7 million colors can be displayed at a time (& color depth).

Inserting the TV image into the image supplied by the graphics board: The
TV image is supplied via the PCI bus, inserted into the image supplied by
the graphics board, and displayed in a window. The playback will be
without jerks and will not depend on the number of colors supplied by the
graphics board. The quality of the TV overlay is better than the & Preview.

Video Electronic Standards Association. Committee founded in 1988 in the
USA which establishes common standards for the computer technology.

Bus concept defined by the & VESA committee: 32-bit bus operating at a
& clock frequency of up to 50 MHz. At a clock frequency of 33 MHz the
VL bus transfers up to 132 & Mbytes per second (max.).

Video Graphics Array (IBM), graphics board which displays 256 colors in

the graphics mode.

Abbreviation for Video Home System. System commonly used for home
VCRs to record and play back images and sound using ½“ tape. VH systems
use & composite signals consisting of brightness and color information.

Video system using a 8 mm tape. Video 8 recorders generate a &
composite signal.

Converts analog signals into digital information.

Converts digital information into analog signals.

Y/C is a signal consisting of two components: Y = Brightness information,
C = Color information.

Color model where Y delivers the brightness information and U and V the
color information.

ROM

Scaling

SECAM

Serial interface

Software

S-VHS

S-Video

TrueColor

TV Overlay

VESA

VESA Local
Bus

VGA

VHS

Video-8

Video decoder

Video encoder

Y/C

YUV
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FCC Compliance Statement

FOR YOUR OWN SAFETY

NOTE: Shielded cables should be used for a composite interface. This is to ensure
continued protection against radio frequency interference.

FCC WARNING STATEMENT

NOTE: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

s Reorient or relocate the receiving antenna.
s Increase the separation between the equipment and receiver.
s Connect the equipment into an outlet on a circuit different from that to which the

receiver is connected.
s Consult the dealer or an experienced radio/TV technician for help.

CAUTION

Changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

Shielded interface cable must be used in order to comply with the emission limits.

LABEL WARNING

This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause undesired
operation.

                        

Pinnacle Systems GmbH         miroVIDEO PCTV

Tested To Comply
With FCC Standards

FOR HOME OR OFFICE USE
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FCC Compliance Statement

FOR YOUR OWN SAFETY

NOTE: Shielded cables should be used for a composite interface. This is to ensure
continued protection against radio frequency interference.

FCC WARNING STATEMENT

NOTE: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

s Reorient or relocate the receiving antenna.
s Increase the separation between the equipment and receiver.
s Connect the equipment into an outlet on a circuit different from that to which the

receiver is connected.
s Consult the dealer or an experienced radio/TV technician for help.

CAUTION

Changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

Shielded interface cable must be used in order to comply with the emission limits.

LABEL WARNING

This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause undesired
operation.

                        

Pinnacle Systems GmbH         miroVIDEO PCTV pro

Tested To Comply
With FCC Standards

FOR HOME OR OFFICE USE
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KONFORMITÄTSERKLÄRUNG
DECLARATION OF CONFORMITY

Geräteart: Multi Media Card
Type of equipment:  Multi Media Card

Produkt / Product : miroVIDEO PCTV

Das bezeichnete Produkt stimmt mit den Vorschriften folgender EU- Richtlinie(n) überein:
The aforementioned product complies with the following European Council directive(s):

89/336/EWG Richtlinie des Rates zur Angleichung der Rechtsvorschriften der Mitgliedstaaten über die
elektromagnetische Verträglichkeit
Council directive 89/336/EEC on the approximation of the laws of the Member States
relating to electromagnetic compatibility

Zur vollständigen Einhaltung dieser Richtlinie(n) wurden folgende Normen herangezogen:
To fully comply with this (these) directive(s), the following standards have been used:

EN 55022 Class B : 1994 / A1:1995
EN 50082-1 : 1992 (IEC 801-2,-4 / ENV50140 / ENV 50141)

Dieser Erklärung liegt zugrunde: Prüfbericht(e) des EMV-Prüflabors
This certification is based on: Test report(s) generated by EMI test laboratory

Aussteller / Holder of certificate : Pinnacle Systems GmbH
Carl-Miele-Str. 4
D - 38112 Braunschweig

Braunschweig, October 08th, 1997

Oliver Hoheisel    Georg Blinn

Engineering Manager  Vorstand / Board of Management
(rechtverbindliche Unterschrift / legally binding)
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KONFORMITÄTSERKLÄRUNG
DECLARATION OF CONFORMITY

Geräteart: Multi Media Card
Type of equipment:  Multi Media Card

Produkt / Product : miroVIDEO PCTVpro

Das bezeichnete Produkt stimmt mit den Vorschriften folgender EU- Richtlinie(n) überein:
The aforementioned product complies with the following European Council directive(s):

89/336/EWG Richtlinie des Rates zur Angleichung der Rechtsvorschriften der Mitgliedstaaten über die
elektromagnetische Verträglichkeit
Council directive 89/336/EEC on the approximation of the laws of the Member States
relating to electromagnetic compatibility

Zur vollständigen Einhaltung dieser Richtlinie(n) wurden folgende Normen herangezogen:
To fully comply with this (these) directive(s), the following standards have been used:

EN 55022 Class B : 1994 / A1:1995
EN 50082-1 : 1992 (IEC801-2, -4, ENV500140, ENV500141)

Dieser Erklärung liegt zugrunde: Prüfbericht(e) des EMV-Prüflabors
This certification is based on: Test report(s) generated by EMI test laboratory

Aussteller / Holder of certificate : Pinnacle Systems GmbH
Carl-Miele-Str. 4
D - 38112 Braunschweig

Braunschweig, October 08th, 1997

Oliver Hoheisel    Georg Blinn

Engineering Manager  Vorstand / Board of Management
(rechtverbindliche Unterschrift / legally binding)
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XIV  miroVIDEO PCTV (pro)

KONFORMITÄTSERKLÄRUNG
DECLARATION OF CONFORMITY

Geräteart: Multi Media Card
Type of equipment:  Multi Media Card

Produkt / Product : miroVIDEO PCTVpro

Das bezeichnete Produkt stimmt mit den Vorschriften folgender EU- Richtlinie(n) überein:
The aforementioned product complies with the following European Council directive(s):

89/336/EWG Richtlinie des Rates zur Angleichung der Rechtsvorschriften der Mitgliedstaaten über die
elektromagnetische Verträglichkeit
Council directive 89/336/EEC on the approximation of the laws of the Member States
relating to electromagnetic compatibility

Zur vollständigen Einhaltung dieser Richtlinie(n) wurden folgende Normen herangezogen:
To fully comply with this (these) directive(s), the following standards have been used:

EN 55022 Class B : 1994 / A1:1995
EN 50082-1 : 1992 (IEC801-2, -4, ENV500140, ENV500141)

Dieser Erklärung liegt zugrunde: Prüfbericht(e) des EMV-Prüflabors
This certification is based on: Test report(s) generated by EMI test laboratory

Aussteller / Holder of certificate : Pinnacle Systems GmbH
Carl-Miele-Str. 4
D - 38112 Braunschweig

Braunschweig, October 08th, 1997

Oliver Hoheisel    Georg Blinn

Engineering Manager  Vorstand / Board of Management
(rechtverbindliche Unterschrift / legally binding)

Notes
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